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WARNINGS

CAREL bases the development of its products on decades of experience in HVAC, 
on continuous investments in technological innovations to products, procedures 
and strict quality processes with in-circuit and functional testing on 100% of its 
products, and on the most innovative production technology available on the 
market. CAREL and its subsidiaries/affiliates nonetheless cannot guarantee that all 
the aspects of the product and the software included with the product respond 
to the requirements of the final application, despite the product being developed 
according to start-of-the-art techniques. 
The customer (manufacturer, developer or installer of the final equipment) accepts 
all liability and risk relating to the configuration of the product in order to reach 
the expected results in relation to the specific final installation and/or equipment. 
CAREL may, based on specific agreements, act as a consultant for the successful 
commissioning of the final unit/application, however in no case does it accept 
liability for the correct operation of the final equipment/system.

The CAREL product is a state-of-the-art product, whose operation is specified in the 
technical documentation supplied with the product or can be downloaded, even 
prior to purchase, from the website www.carel.com. 
Each CAREL product, in relation to its advanced level of technology, requires setup/
configuration/programming/commissioning to be able to operate in the best 
possible way for the specific application. Failure to complete such operations, 
which are required/indicated in the user manual, may cause the final product to 
malfunction; CAREL accepts no liability in such cases.
Only qualified personnel may install or carry out technical service on the product.
The customer must only use the product in the manner described in the 
documentation relating to the product.

In addition to observing any further warnings described in this manual, the 
following warnings must be heeded for all CAREL products:
• Prevent the electronic circuits from getting wet. Rain, humidity and all types of 

liquids or condensate contain corrosive minerals that may damage the electronic 
circuits. In any case, the product should be used or stored in environments that 
comply with the temperature and humidity limits specified in the manual.

• Do not install the device in particularly hot environments. Too high temperatures 
may reduce the life of electronic devices, damage them and deform or melt the 
plastic parts. In any case, the product should be used or stored in environments 
that comply with the temperature and humidity limits specified in the manual.

• Do not attempt to open the device in any way other than described in the 
manual.

• Do not drop, hit or shake the device, as the internal circuits and mechanisms 
may be irreparably damaged.

• Do not use corrosive chemicals, solvents or aggressive detergents to clean the 
device.

• Do not use the product for applications other than those specified in the 
technical manual.

All of the above suggestions likewise apply to the controllers, serial cards, 
programming keys or any other accessory in the CAREL product portfolio.

CAREL adopts a policy of continual development. Consequently, CAREL reserves 
the right to make changes and improvements to any product described in this 
document without prior warning.

The technical specifications shown in the manual may be changed without prior 
warning.

The liability of CAREL in relation to its products is specified in the CAREL general 
contract conditions, available on the website www.carel.com and/or by specific 
agreements with customers; specifically, to the extent where allowed by applicable 
legislation, in no case will CAREL, its employees or subsidiaries/affiliates be liable 
for any lost earnings or sales, losses of data and information, costs of replacement 
goods or services, damage to things or people, downtime or any direct, indirect, 
incidental, actual, punitive, exemplary, special or consequential damage of any 
kind whatsoever, whether contractual, extra-contractual or due to negligence, or 
any other liabilities deriving from the installation, use or impossibility to use the 
product, even if CAREL or its subsidiaries/affiliates are warned of the possibility of 
such damage.

DISPOSAL

INFORMATION FOR USERS ON THE CORRECT HANDLING OF WASTE 
ELECTRICAL AND ELECTRONIC EQUIPMENT (WEEE)
 
In reference to European Union directive 2002/96/EC issued on 27 January 
2003 and related national legislation, please note that:
1. WEEE cannot be disposed of as municipal waste and such waste must 

be collected and disposed of separately;
2. the public or private waste collection systems defined by local legislation 

must be used. In addition, the equipment can be returned to the 
distributor at the end of its working life when buying new equipment;

3. the equipment may contain hazardous substances: the improper use or 
incorrect disposal of such may have negative effects on human health 
and on the environment;

4. the symbol (crossed-out wheeled bin) shown on the product or on the 
packaging and on the technical leaflet indicates that the equipment has 
been introduced onto the market after 13 August 2005 and that it must 
be disposed of separately;

5. in the event of illegal disposal of electrical and electronic waste, the 
penalties are specified by local waste disposal legislation.

Warranty on materials: 2 years (from production date, excluding 
consumables).

Approval: the quality and safety of CAREL INDUSTRIES Hq products are 
guaranteed by the ISO 9001 certified design and production system.

NO POWER 
& SIGNAL 
CABLES 

TOGETHER

READ CAREFULLY IN THE TEXT!

IMPORTANT: Separate as much as possible the probe and digital input cables 
from cables to inductive loads and power cables, so as to avoid possible 
electromagnetic disturbance. Never run power cables (including the electrical 
panel cables) and signal cables in the same conduits.

KEY TO THE SYMBOLS

Caution: to bring critical issues to the attention of those using the 
product.

Notice: to focus attention on important topics; in particular the 
practical application of the various product functions.

Caution: this product is to be integrated and/or incorporated into 
the final apparatus or equipment. Verification of conformity to the 
laws and technical standards in force in the country where the final 
apparatus or equipment will be operated is the manufacturer’s 
responsibility. Before delivering the product, Carel has already 
completed the checks and tests required by the relevant European 
directives and harmonised standards, using a typical test setup, 
which however cannot be considered as representing all possible 
conditions of the final installation.
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1. INTRODUCTION 
This guide has been created with the aim of supporting uChiller users 
for replacement in the field of the microchiller2 SE (hereinafter mCH2 SE) 
with the new product (hereinafter Legacy model).

This document contains specific information on the Legacy models.
For other functions, see the µChiller manual +0300053** rel. 1.3 and higher.

List of Legacy models and dedicated accessories used to replace mCH2 SE.

P/N Assembly Connectivity Compressor manage-
ment: Remarks Electronic valve management

UCHBP000X0190 panel NFC On/Off standard version bipolar: with EVD Evolution driver
UCHBP000X0200 panel NFC, Bluetooth (BLE) On/Off standard version bipolar: with EVD Evolution driver
UCHBD000X1230 DIN rail - On/Off standard version bipolar: with EVD Evolution driver

Tab. 1.a 

Accessory P/N Description
UCHCONPMC0 Adapter kit for MCH2 

Tab. 1.b 

Below is the list of MCH2 and MCH2-SE products and I/O expansions that 
can be replaced with the new uChiller

Part number Description Replacement product
MCH200000* MICROCHILLER 2 B.IN VERS,1 CIRCUIT, 2 COMPRES. UCHBP000X0190 / UCHBP000X0200
MCH200003* MCH 2 SE MAX 1 CIRC. 2 COMPR. UCHBP000X0190 / UCHBP000X0200
MCH200103* MCH 2 SE MAX 1 CIRC. 2 COMPR. + RTC UCHBP000X0190 / UCHBP000X0200
MCH201000* MICROCHILLER 2 MAX 1 CIRC. 2 COMPR. WITH NEUTRAL PLASTIC UCHBP000X0190 / UCHBP000X0200
MCH201003* MCH 2 SE MAX 1 CIRC. 2 COMPR. WITHOUT LOGO UCHBP000X0190 / UCHBP000X0200
MCH201103* MCH 2 SE MAX 1 CIRC. 2 COMPR. + RTC WITHOUT LOGO UCHBP000X0190 / UCHBP000X0200
MCH200001* MICROCHILLER 2 DIN VERS, 1 CIRCUIT, 2 COMPRES. UCHBD000X1230
MCH200002* MICROCHILLER 2 EXPANS. MAX 2 CIRC. 4 COMPR. UCHBE00001230

Tab. 1.c 

1.1 Main functions
Ref. Description
Main features Up to two circuits and 2 + 2 compressors

Tandem compressor configuration 
Air/water (A/W) and water/water chiller or heat pump
Air/air unit (A/A)
Condensing unit (MC)
Up to 2 evaporators per unit

Hardware Panel mounting model
DIN rail model

User interface 7-segment, 2-row LED display, optional pGDx graphic display, communication via APPLICA app (compatible with NFC and BTLE) 
for mobile devices

Temperature control PID at start-up
PID in operation
Set point compensation on outdoor temperature

Compressor rotation FIFO or timed
Compressor management Generic scroll compressors
Circuit destabilisation Forced compressor rotation (extended operation at part load)
Electronic valve driver External driver management via FieldBus port (all versions)
Programming with time 
bands

Unit ON-OFF or 2nd set point (1 time band per day)
"Noise reduction" function for condenser fans (1 time band per day)

System pumps 1/2 pumps (2 pumps only with 2 circuits)
Rotation by time or with pump overload alarm
Cyclical activation during standby

Water-cooled condenser 1 common pump for both circuits
Air-cooled condenser Independent fans on each circuit or common to both circuits

Fan modulation based on condensing temperature (On/Off fan control via relay or CAREL CONVONOFF0 module)
Optimised start-up to quickly bring the compressor(s) to steady operation
Fan anti-block protection (harsh climate)

Defrost Simultaneous
Separate
Independent
Only when the fans are used
Defrost interval managed based on outside temperature ("sliding defrost")

Prevent Prevention of scroll compressor operating limits in relation to condensing and evaporation temperature 
Evaporator frost prevention

Alarms 
(see the chapter on Alarms) 

Management of automatic and manual reset according to alarm severity
Alarm log (up to 20 events): alarm and reset date and time recorded

Connectivity/supervision RS485 serial port
Modbus RTU
Baud rate up to 115200 bit/s
Frame configurable by Parity (None, Even, Odd) and StopBits (1 or 2); Databits fixed at 8 bits.

Tab. 1.d 
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2. INSTALLATION

2.1 Warnings
Caution: avoid installing the controller in environments with the 
following characteristics:
• temperature and humidity that do not comply with the ambient 

operating conditions (see "Technical specifications");
• strong vibrations or knocks;
• exposure to water sprays or condensate;
• exposure to aggressive and polluting atmospheres (e.g.: sulphur and 

ammonia gases, saline mist, smoke) which may cause corrosion and/
or oxidation;

• strong magnetic and/or radio frequency interference (thus avoid 
installation near transmitting antennae);

• exposure to direct sunlight and the elements in general;
• wide and rapid fluctuations in ambient temperature;
• exposure to dust (formation of corrosive patina with possible oxidation 

and reduction of insulation).

2.2 Panel version

2.2.1 Dimensions in mm (inches)

Fig. 2.a

2.2.2 Assembly

Caution: before carrying out any maintenance, disconnect the controller 
from the power supply by moving the main system switch to “off”.

Fig. 2.b

1. Place the controller in the opening, pressing lightly on the side 
anchoring tabs.

2. Then press on the front until fully inserted (the side tabs will bend, 
and the catches will attach the controller to the panel).

Caution: IP65 front protection is guaranteed only if the following 
conditions are met:
• maximum deviation of the rectangular opening from flat surface: ≤ 0.5 

mm;
• thickness of the electrical panel sheet metal: 0.8-2 mm;
• maximum roughness of the surface where the gasket is applied: ≤ 120 

μm.

Notice: the thickness of the sheet metal (or material) used to make the 
electrical panel must be adequate to ensure safe and stable mounting of 
the product..

2.2.3 Assembly

Fig. 2.a

Open the electrical panel from the rear and press the anchoring tabs and 
then the controller to remove it.
1. Gently press the side anchoring tabs on the controller;
2. Exert slight pressure on the controller until it is removed.

Caution: the operation does not require the use of a screwdriver or other 
tools.

2.3 DIN rail version

2.3.3 Dimensions - mm (in)
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Fig. 2.c

Apply slight pressure to the controller resting on the DIN rail until the rear 
tab clicks into place.

2.3.4 Assembly

Use a screwdriver as a lever in the hole to lift and release the tab. The tab 
is held in the locked position by return springs.

2.4 Electrical installation
Caution: before carrying out any maintenance, disconnect the controller 
from the power supply by moving the main system switch to “off”.

2.4.1 Adapter kit for MCH2
Using the UCHCONPMC0 adapter kit, 
installers can replace the mCH2 SE with the 
corresponding uCH legacy model in just a 
few minutes, utilising the existing wiring in 
the unit’s electrical panel.

**NDR : l’immagine è presente nella news uChiller 2021_04_30

If the adapter kit is not available, see the following paragraphs.
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2.4.2 Description of the terminals

Panel model

Fig. 2.d

DIN rail model

Basic

Fig. 2.e

Ref. Description
J1 G Power supply

G0 Power supply: reference
J2 5V Ratiometric probe power supply

S3 Analogue input 3
S1 Analogue input 1
Y1 Analogue output 1
ID1 Digital input 1
O GND: reference for probes, digital inputs and analogue 

outputs
S5 Analogue input 5
S2 Analogue input 2
Y2 Analogue output 2
ID2 Digital input 2

J3 ID3 Digital input 3
ID5 Digital input 5
+V Power supply to 4-20 mA active probes
S6 Analogue input 6
VL Not used
ID4 Digital input 4
O GND: reference for analogue and digital inputs
S4 Analogue input 4

J4 - BMS serial port (RS485): Rx-/Tx-
+ BMS serial port (RS485): Rx+/Tx+
O BMS serial port (RS485): GND

J5 - Fieldbus serial port (RS485): Rx-/Tx-
+ Fieldbus serial port (RS485): Rx+/Tx+
O Fieldbus serial port (RS485): GND

J6 C Common for relays 1, 2, 3.4
NO1 Digital output (relay) 1
NO2 Digital output (relay) 2
NO3 Digital output (relay) 3
NO4 Digital output (relay) 4

J7 C Common for relay 5
NO5 Digital output (relay) 5

J8 - Unit terminal connector (AX5* or PGR04*)
J9 S7 Analogue input 7

ID6 Digital input 6
O Input reference
O Input reference

J11 - (not used)
C Common for relay 6
NO6 Digital output (relay) 6

Tab. 2.a 

2.5 Probe/digital input connection

NTC probes

Fig. 2.f

4-20 mA probes/digital inputs

Fig. 2.g

0-10 Vdc probes

Fig. 2.h

0-5 V ratiometric pressure probes

Fig. 2.i
Notice: O = GND



10

ENG

µchiller  +040000103  rel. 1.1 - 18.07.2022

2.6 Connection to user terminals

2.6.1 Panel model

Fig. 2.j

2.6.2 DIN rail model

Fig. 2.k

Connection to connector J4

Fig. 2.l

Connection to connector J8

Fig. 2.m

Notice 2: in cases (1) and (4), set the BMS port communication parameters 
as shown in the table:

Communication parameters

User Display P/N Description Value Min Max UOM
S x Hd00 BMS: serial address 1 1 247 -
S x Hd01 BMS: baud rate

3=9600; 4=19200; 5=38400;
6=57600; 7=115200

6 3 7 -

S Hd02 BMS: settings
0=8-NONE-1; 1=8-NONE-2; 2=8-EVEN-1
3=8-EVEN-2; 4=8-ODD-1; 5=8-ODD-2

0 0 5 -

Tab. 2.b 

2.7 Positioning inside the panel
The position of the controller in the electrical cabinet must be chosen so 
as to guarantee correct physical separation from the power components 
(solenoids, contactors, actuators, inverters, ...) and the connected cables. 
Proximity to such devices/cables may create random malfunctions that 
are not immediately evident. The structure of the panel must allow the 
correct flow of cooling air.
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2.8 Electrical installation
Caution: When laying the wiring, “physically” separate the power part 
from the control part.  The proximity of these two sets of wires will, in most 
cases, cause problems of induced disturbance or, over time, malfunctions 
or damage to the components. The ideal solution is to house these two 
circuits in two separate cabinets. Sometimes this is not possible, and 
therefore the power part and the control part must be installed in two 
separate areas inside the same panel.
For the control signals, it is recommended to use shielded cables with 
twisted wires. If the controller cables have to cross over the power cables, 
the intersections must be as near as possible to 90 degrees, always 
avoiding running the controller cables parallel to the power cables.

Pay attention to the following warnings:
• use cable ends suitable for the corresponding terminals. Loosen each 

screw and insert the cable ends, then tighten the screws. When the 
operation is completed, slightly tug the cables to check they are 
sufficiently tight;

• separate as much as possible the probe signal, digital input and serial 
line cables from the cables carrying inductive loads and power cables 
to avoid possible electromagnetic disturbance. Never run power cables 
(including the electrical cables) and probe signal cables in the same 
conduits. Do not install the probe cables in the immediate vicinity of 
power devices (contactors, circuit breakers or similar);

• reduce the path of the probe cables as much as possible, and avoid 
spiral paths that enclose power devices;

• avoid touching or nearly touching the electronic components fitted 
on the boards to avoid electrostatic discharges (extremely damaging) 
from the operator to the components;

• do not secure the cables to the terminals by pressing the screwdriver 
with excessive force, to avoid damaging the controller: maximum 
tightening torque: 0.22-0.25 N•m. For applications subject to 
considerable vibrations (1.5 mm pk-pk 10/55 Hz), secure the cables 
connected to the controller around 3 cm from the connectors using 
clamps;

• all the extra low voltage connections (analogue and digital inputs, 
analogue outputs, serial bus connections, power supplies) must have 
reinforced or double insulation from the mains network.

2.9 Connecting serial ports with two 
circuits

For serial connections (FBus and BMS ports), the cables used must 
be suitable for the RS485 standard (shielded twisted pair, see the 
specifications in the following table). The earth connection of the shield 
must be made using the shortest connection possible on the metal plate 
at the bottom of the electrical panel.

Master 
device

Serial 
port

Lmax 
(m)

Wire/
wire 
capac-
itance 
(pF/m)

Resistance on 
first and last 
device

Max no. 
slave devic-
es on bus

Data 
rate 
(bit/s)

μChiller FBus 10 <90 120 Ω 16 19200
PC 
(super-
vision)

BMS 500 <90 120 Ω 16 115200

Tab. 2.c 
Notice: 120 Ω 1/4W terminating resistors on the first and last devices in 
the network must be used when the length exceeds 100 m.

For two-circuit units, the power supply connections must be in phase 
between the two controllers (G0 on the master controller and G0 on the 
slave controller connected to the same power supply wire); the serial 
connection between the two controllers (J5 FBus on the master and J4 
BMS on the slave) must be made as shown in the figure (+ with + and - 
with -).

Fig. 2.n
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2.10 Source fan speed controller
The typical connections on mCH2 / mCH2 SE to manage the source fans 
and how these change with the new mChiller are shown below.

Case 1: ON-OFF fan management

Fig. 2.o

ON/OFF management of condensing fans is possible by using the 
CONVONOFF0 module connected to mCH2 / mCH2 SE.
The control relay has a switchable power of 10 A at 250 Vac in AC1 (1/3 
HP inductive).

Operation is similar with the new uCHiller. To manage the condensing 
fan in this mode, simply connect terminals 3 and 4 on the CONVONOFF0 
module to terminals Y1 and GND (connector J2) on the UCHB*000X****.

Case 2: PWM fan speed management (MCHRTF*)

Fig. 2.p

The MCHRTF* single-phase voltage regulators use the phase cutting 
principle to regulate the effective output voltage to the load, based on 
the phase α of the control PWM signal.
The command from mCH2 / mCH2 SE is sent by connecting terminals Y 
and GND on MCHRTF* to the corresponding terminals on mCH2 / mCH2.

Specifically, when replacing mCH2 / mCH2 SE, the installer also needs 
to replace the MCHRTF* device, as the new uChiller manages 0-10 Vdc 
speed controllers to ensure higher precision and greater immunity to 
interference.

The following table shows the replacement models for MCHRTF*

Part number Description Replacement 
product

MCHRTF04C0 Fan speed controller-cut phase PWM  
4A/230Vac Faston

FCSM042300

MCHRTF08C0 Fan speed controller-cut phase PWM  
8A/230Vac Faston

FCSM082300

MCHRTF12C0 Fan speed controller-cut phase PWM  
12A/230Vac Faston

FCSM122300

Tab. 2.a 

Case 3: 0-10 Vdc fan speed management

Fig. 2.q

The CONV0/10A0 module converts the PWM signal into a standard 0-10 
Vdc (or 4-20 mA) signal.
This module is required if needing to use a non-Carel speed controller. 

With the new uCHiller, to manage the condensing fan in this mode, 
simply remove the CONV0/10A0 module and connect the wires from 
terminals 5 and 6 on the CONV0/10A0 module to terminals Y1 and GND 
(connector J2) on UCHB*000X****.

Case 4: Fan speed management with FCS* module

Fig. 2.r

mCH2 / mCH2SE can directly manage single-phase and three-phase 
FCS* speed controllers.
In this case, the “IN+” and “IN-” terminals on FCS* are connected to 
terminals “Y” and “GND” on mCH2 / mCH2 SE respectively
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Fig. 2.s

With the new uCHiller, to manage the condensing fan in this mode, 
simply connect the wires from the “IN+” and “IN-” terminals on FCS* to 
terminals “Y” and “GND” (connector J2) on UCHB*000X****.
Pin-strip JP7 also needs to be set to 0-10 Vdc mode (as shown in the 
image on the side).

2.11 Electronic expansion valve driver

Fig. 2.t

mCH2 / mCH2 SE, when connected to the EVD4* driver can manage 
electronic expansion valves via the tLAN serial line.

When replacing mCH2 / mCH2 SE, the installer should also replace the 
EVD4* device, as EVD4* is now obsolete and no longer supported by 
Carel.

The EVD4* driver should be replaced with EVD EVO.

Notice: for information regarding the connections and the configuration 
of EVD EVO, see the corresponding product manual.
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3. INPUT/OUTPUT CONFIGURATION
Information on how to configure the µChiller Legacy inputs and outputs 
to replace mCH2 and mCH2 SE is shown below.

Panel mounting model

J1J7
G0 G

J6

C CNO
1

NO
2

NO
3

NO
4

NO
5

J2J3
J4 BMSJ5 FBus

S1 S3 5V
S2Y2

Y1ID1
ID2

ID3ID5
ID4S4

S6 +V
VL S5

Fig. 3.a

DIN rail model (Basic)

J1

J7

G0 G

J6

C CNO
1

NO
2

NO
3

NO
4

NO
5

J2J3
J4 BMSJ5 FBus

S1 S3 5V
S2Y2

Y1ID1
ID2

ID3ID5
ID4S4

S6 +V
VL S5

J11
C NO6

J9

J8

S7ID6

Basic Fig. 3.b

3.1 Analogue inputs
The analogue inputs on µChiller Legacy are divided into four groups, 
according to the type of sensor connected. The groups and the list of 
parameters used to configure the different analogue inputs are shown 
below:

Group Sensor Master 
config. parameter

Slave 
config. parameter

GRP1 S1 HC31 HC41
S2 HC32 HC42
S3 HC00 HC43

GRP2 S4 HC34 HC44
S5 HC35 HC45

GRP3 S6 HC03 HC05
GRP1* S7* HC04* HC47

Tab. 3.a 
(*) available only on DIN version

The meanings assigned to the analogue inputs according to the various 
groups for the Master controller (circuit 1) are as follows:

Value GRP1 GRP2 GRP3
0 Not used Not used Not used
1 Source water delivery 

temp.
Source water delivery 
temp.

Source water delivery 
temp.

2 Outside temperature Outside temperature Outside temperature
3 Discharge  

temperature circuit 1
Discharge  
temperature circuit 1

Remote set point

4 Condensing  
temperature circ. 1

Condensing  
temperature circ. 1

Discharge tempera-
ture circuit 1

5 Suction  
temperature circ. 1

Suction  
temperature circ. 1

Condensing  
temperature circ. 1

6 Evaporation  
temperature circ. 1

Evaporation  
temperature circ. 1

Suction  
temperature circ. 1

7 System water  
return temperature

Condensing  
pressure circ. 1

Evaporation  
temperature circ. 1

8 System water deliv-
ery temp.

Evaporation  
pressure circ. 1

Condensing  
pressure circ. 1

9 System water  
return temperature

Evaporation  
pressure circ. 1

10 System water deliv-
ery temp.

System water  
return temperature

11 System water deliv-
ery temp.

Tab. 3.b 

The meanings assigned to the analogue inputs according to the various 
groups for the Slave controller (circuit 2) are as follows:

Value GRP1 GRP2 GRP3
0 Not used Not used Not used
1 Source water delivery 

temp.
Source water delivery 
temp.

Source water delivery 
temp.

2 Outside temperature Outside temperature Outside temperature
3 Discharge  

temperature circuit 2
Discharge  
temperature circuit 2

Remote set point

4 Condensing  
temperature circ. 2

Condensing  
temperature circ. 2

Discharge  
temperature circuit 1

5 Suction  
temperature circ. 2

Suction  
temperature circ. 2

Condensing  
temperature circ. 1

6 Evaporation  
temperature circ. 2

Evaporation  
temperature circ. 2

Suction  
temperature circ. 1

7 Common water  
delivery temperature

Condensing  
pressure circ. 2

Evaporation  
temperature circ. 1

8 Evap. water delivery 
temp. 2

Evaporation  
pressure circ. 2

Condensing  
pressure circ. 2

9 Common water  
delivery temperature

Evaporation  
pressure circ. 2

10 Evap. water delivery 
temp. 2

Common water  
delivery temperature

11 Evaporation  
pressure circ. 2

Tab. 3.c 

3.2 Digital inputs
Below is the list of parameters used to configure the digital inputs:

Digital 
input

Master  
configuration parameter

Slave  
configuration parameter

ID1 HC14 HC16
ID2 HC15 HC17
ID3 High pressure  

switch circ. 1
High pressure  
switch circ. 2

ID4 HC06 HC09
ID5 HC07 HC10
ID6* HC08* HC11

Tab. 3.d 
(*) available only on DIN version
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The digital input configuration parameters can have the following 
meaning:

Value Master description (circuit 1) Slave description (circuit 2)
0 Not used Not used
1 System pump flow switch System pump flow switch
2 Comp. 1 thermal protector circ. 1 Comp. 1 thermal prot circ. 2
3 Comp. 2 thermal protector circ. 1 Comp. 2 thermal prot. circ. 2
4 Remote on/off Remote on/off
5 Cooling/heating Cooling/heating
6 2nd set point 2nd set point
7 Remote alarm Remote alarm
8 System pump 1 thermal pro-

tector 
System pump 1 thermal 
protector

9 Low pressure switch circ. 1 Low pressure switch circ. 2
10 System pump 2 thermal pro-

tector 
System pump 2 thermal 
protector

11** Comp. 1 request circ. 1 Comp. 1 request circ. 2
12** Comp. 2 request circ. 1 Comp. 2 request circ. 2

Tab. 3.e 
(**) available only for condensing units

3.3 Analogue outputs
Below is the list of parameters used to configure the analogue outputs:

Analogue
output

Master  
configuration parameter

Slave  
configuration parameter

Y1 HC71 HC81
Y2 HC72 HC82

Tab. 3.f 

The analogue input configuration parameters can have the following 
meaning:

Value Master description (circuit 1) Slave description (circuit 2)
0 Not used Not used
1 On-off source  

fan/pump circ. 1
On-off source 

fan/pump circ. 2
2 Modulating source  

fan circ. 1
Modulating source  

fan circ. 2
3 Free cooling Free cooling

Tab. 3.g 

3.4 Digital outputs
Below is the list of parameters used to configure the digital outputs:

Digital
input

Master 
configuration parameter

Slave
configuration parameter

NO1 HC51 HC61
NO2 HC52 HC62
NO3 HC53 HC63
NO4 HC54 HC64
NO5 HC55 HC65
NO6* HC56 HC66

Tab. 3.h 
(*) available only on DIN version

The digital output configuration parameters can have the following 
meaning:

Value Master description (circuit 1) Slave description (circuit 2)
0 Not used Not used
1 Compressor1 circuit 1 Compressor1 circuit 2
2 Compressor 2 circuit 1 Compressor 2 circuit 2
3 System heater 1 System heater 2
4 System pump 1 / 

system fan
System pump 2

5 Source pump / fan Source pump / fan
6 Frost protection heater 

evaporator 1
Frost protection heater 
evaporator 2

7 4-way valve circuit 1 4-way valve circuit 2
8 Oil equalisation 

valve circuit 1
Oil equalisation 
valve circuit 2

9 Freecooling valve
10 General alarm
11 System pump 2
12 System heater 2

Tab. 3.i 
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4. APPLICATION COMPATIBILITY

Below is a summary table for the correct configuration of the unit type on uChiller, starting from parameter Hd01 on uCh2 and uCH2SE.

uChiller Legacy parameter key
U077 : Type of unit 
S068 : Source type (FALSE = Air, TRUE = Water)
ModE : Cooling/heating mode from keypad 
(FALSE = Cooling TRUE = Heating)

uCH2se uChiller (legacy)
H01 U077 S068 ModE
0 = air-air unit 5 ---- ----
1 = air-air heat pump 6 ---- FALSE = CH

TRUE = HP
2 = air-water chiller 0 FALSE ----
3 = air-water heat pump 2 FALSE FALSE = CH

TRUE = HP
4 = water-water chiller 0 TRUE ----
5 = water-water heat pump with reverse-cycle on gas circuit 2 TRUE FALSE = CH

TRUE = HP
6 = water-water heat pump with reverse-cycle on water circuit 7 TRUE FALSE = CH

TRUE = HP
7 = condensing unit 3 FALSE ----
8 = condensing unit with reverse-cycle 4 FALSE FALSE = CH

TRUE = HP
9 = water-cooled condensing unit 3 TRUE ----
10 = water-cooled condensing unit with reverse-cycle 4 TRUE FALSE = CH

TRUE = HP
11 = air-air cooling only unit with electric heating ---- ---- ----

Tab. 4.a 

4.1 Air/air

4.1.1 Single circuit

Key:
1 condenser fan thermal protector
2 condenser fan
3 condenser probe
4 supply probe
5 heater
6 evaporator
7 supply fan thermal protector
8 supply fan
9 compressor 1
10 high pressure
11 compressor thermal protector
12 low pressure
13 room probe
14 compressor 2

Fig. 4.a 
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4.1.2 Two circuits

Key:
1 condenser fan 1 & 2 thermal protector
2 fan
3 condenser probe
4 supply probe
5 heater 1 & 2
6 evaporator 1 & 2
7 supply fan thermal protector
8 supply fan
9 compressor 1 circuit 1
10 high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 room probe
14 compressor 2 circuit 1
15 compressor 1 circuit 2
16 compressor 2 circuit 2

Fig. 4.b 

4.1.3 Two circuits, 1 condensing ventilation circuit

Key:
1 condenser fan thermal protector
2 fan
3 condenser probe 1 & 2
4 supply probe
5 heater 1 & 2
6 evaporator 1 & 2
7 supply fan
8 room probe
9 compressor 1 circuit 1
10  high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 compressor 1 circuit 1
14 compressor 1 circuit 2
15 compressor 2 circuit 2

Fig. 4.c 
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4.2 Reverse-cycle air/air units

4.2.1 Single circuit

Key:
1 condenser fan thermal protector
2 fan
3 condenser probe
4 supply probe
5 heater
6 evaporator
7 supply fan thermal protector
8 supply fan
9 compressor 1
10 high pressure
11 compressor thermal protector
12 low pressure
13 room probe
14 compressor 2
15 reversing valve

Fig. 4.d 

4.2.2 Two circuits
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Key:
1 condenser fan 1 & 2 thermal protector
2 fan
3 condenser probe
4 supply probe
5 heater 1 & 2
6 evaporator 1 & 2
7 supply fan thermal protector
8 supply fan
9 compressor 1 circuit 1
10 high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 room probe
14 compressor 2 circuit 1
15 reversing valve
16 compressor 1 circuit 2
17 compressor 2 circuit 2

Fig. 4.e 
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4.2.3 Two circuits, 1 condensing ventilation circuit
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Key:
1 condenser fan thermal protector
2 fan
3 condenser probe 1 & 2
4 supply probe
5 heater 1 & 2
6 evaporator 1 & 2
7 supply fan thermal protector
8 supply fan
9 compressor 1 circuit 1
10 high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 room probe
14 compressor 2 circuit 1
15 reversing valve
16 compressor 1 circuit 2
17 compressor 2 circuit 2

Fig. 4.f 

4.3 Air/water chillers

4.3.1 Single circuit

Key:

1 condenser fan thermal protector
2 fan
3 condenser probe
4 flow switch
5 evaporator outlet probe
6 evaporator
7 frost protection heater
8 evaporator inlet probe
9 compressor 1
10 high pressure
11 compressor thermal protector
12 low pressure
13 water pump
14 compressor 2

Fig. 4.g 
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4.3.2 Two circuits, 2 condensing ventilation circuits and 2 evaporators

Key:
1 condenser fan 1 & 2 thermal protector
2 fan
3 condenser probe
4 flow switch
5 common evaporator outlet probe
6 evaporator 1 & 2
7 evaporator outlet probe 1 & 2
8 frost protection heater 1 & 2
9 compressor 1 circuit 1
10 high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 room probe
14 compressor 2 circuit 1
15 water pump
16 compressor 1 circuit 2
17 compressor 2 circuit 2

Fig. 4.h 

4.3.3 Two circuits, 1 condensing ventilation circuit 

Key:

1 condenser fan thermal protector
2 fan
3 condenser probe 1 & 2
4 flow switch
5 supply temperature probe
6 evaporator 1 & 2
7 evaporator outlet probe 1 & 2
8 frost protection heater 1 & 2
9 compressor 1 circuit 1
10 high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 evaporator inlet probe
14 compressor 2 circuit 1
15 water pump
16 compressor 1 circuit 2
17 compressor 2 circuit 2

Fig. 4.i 
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4.4 Reverse-cycle air/water units

4.4.1 Single circuit

Key:
1 condenser fan thermal protector
2 fan
3 condenser probe
4 flow switch
5 evaporator outlet probe
6 evaporator
7 frost protection heater
8 evaporator inlet probe
9 compressor 1
10 high pressure
11 compressor thermal protector
12 low pressure
13 room probe
14 compressor 2

Fig. 4.j 

4.4.2 Two circuits, 2 condensing ventilation circuits 

Key:
1 condenser fan 1 & 2 thermal protector
2 fan
3 condenser probe
4 flow switch
5 common evaporator probe
6 evaporator 1 & 2
7 evaporator outlet probe 1 & 2
8 supply fan
9 compressor 1 circuit 1
10 high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 evaporator inlet probe 1 & 2
14 compressor 2 circuit 1
15 water pump
16 reversing valve
17 compressor 1 circuit 2
18 compressor 2 circuit 2

Fig. 4.k 
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4.4.3 Two circuits, 1 condensing ventilation circuit

Key:
1 condenser fan 1 & 2 thermal protector
2 fan
3 condenser probe
4 flow switch
5 common evaporator probe
6 evaporator 1 & 2
7 evaporator outlet probe 1 & 2
8 supply fan
9 compressor 1 circuit 1
10 high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 evaporator inlet probe 1 & 2
14 compressor 2 circuit 1
15 water pump
16 reversing valve
17 compressor 1 circuit 2
18 compressor 2 circuit 2

Fig. 4.l 

4.5 Air/water chillers

4.5.1 Single circuit

Key:
1 cond. water temperature probe
2 condenser
3 flow switch
4 evaporator outlet probe
5 evaporator
6 frost protection heater
7 evaporator inlet probe
8 compressor 1
9 high pressure
10 compressor thermal protector
11 low pressure
12 water pump
13 compressor 2
14 compressor 2

Fig. 4.m 
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4.5.2 Two circuits, 1 evaporator

Key:
1 Cond. water temperature probe 1 & 2
2 Condenser 1 & 2
3 flow switch
4 evaporator outlet probe
5 evaporator
6 frost protection heater
7 Compressor 1 circuit 1
8 High pressure 1 & 2
9 Compressor 1 & 2 thermal protector
10 Low pressure 1 & 2
11 Evaporator inlet probe
12 Water pump
13 Compressor 2 circuit 1
14 Compressor 1 circuit 2
15 Compressor 2 circuit 2

Fig. 4.n 

4.5.3 Two circuits, 2 evaporators

Key:
1 Cond. water temperature probe 1 & 2
2 Condenser 1 & 2
3 flow switch
4 common evaporator outlet probe
5 evaporator outlet probe 1 & 2
6 frost protection heater 1 & 2
7 Evaporator 1 & 2
8 Water pump
9 Compressor 1 circuit 1
10 High pressure 1 & 2
11 Compressor 1 & 2 thermal protector
12 Low pressure 1 & 2
13 Compressor 1 circuit 2
14 Compressor 2 circuit 1
15 Compressor 2 circuit 2

Fig. 4.o 
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4.6 Reverse-cycle water/water units

4.6.1 Single circuit

Key:
1 Cond. water temperature probe
2 condenser
3 flow switch
4 Evaporator outlet probe
5 evaporator
6 Reversing valve
7 Evaporator inlet probe
8 compressor
9 High pressure
10 compressor thermal protector
11 Low pressure
12 Water pump
13 Compressor 2

Fig. 4.p 

4.6.2 Two circuits
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Key:
1 cond. water temperature probe 1 & 2
2 condenser 1 & 2
3 flow switch
4 evaporator outlet probe
5 evaporator outlet probe 1 & 2
6 evaporator 1 & 2
7 frost protection heater 1 & 2
8 water pump
9 compressor 1 circuit 1
10 high pressure 1 & 2
11 compressor 1 & 2 thermal protector
12 low pressure 1 & 2
13 evaporator inlet probe
14 compressor 2 circuit 1
15 compressor 1 circuit 2
16 reversing valve 1 & 2
17 compressor 2 circuit 2

Fig. 4.q 
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4.6.3 Two circuits, 1 evaporator
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Key:
1 condenser probe 1 & 2
2 condenser 1 & 2
3 flow switch
4 evaporator outlet probe
5 evaporator
6 frost protection heater 1 & 2
7 compressor 1 circuit 1
8 high pressure 1 & 2
9 compressor 1 & 2 thermal protector
10 low pressure 1 & 2
11 evaporator inlet probe
12 water pump
13 compressor 2 circuit 1
14 reversing valve 1 & 2
15 compressor 1 circuit 2
16 compressor 2 circuit 2

Fig. 4.r 

4.7  Air-cooled condensing unit

4.7.1 Single circuit

2
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5 6 7

8

Key:
1 condenser fan thermal protector
2 fan
3 condenser probe
4 compressor 1
5 high pressure
6 compressor thermal protector
7 low pressure
8 compressor 2

Fig. 4.s 
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4.7.2 Two circuits
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Key:
1 condenser fan thermal protector
2 fan
3 condenser probe
4 compressor 1 circuit 1
5 high pressure 1 & 2
6 compressor 1 & 2 thermal protector
7 low pressure 1 & 2
8 compressor 2 circuit 1
9 compressor 1 circuit 2
10 compressor 2 circuit 2

Fig. 4.t 

4.8 Reverse-cycle air-cooled condensing unit

4.8.1 Single circuit
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9

Key:
1 condenser fan thermal protector
2 fan
3 condenser probe
4 compressor 1
5 high pressure
6 compressor thermal protector
7 low pressure
8 compressor 2
9 reversing valve

Fig. 4.u 
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4.8.2 Two circuits, 1 condensing ventilation circuit
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Key:
1 condenser fan thermal protector
2 fan
3 condenser probe
4 compressor 1 circuit 1
5 high pressure 1 & 2
6 compressor 1 & 2 thermal protector
7 low pressure 1 & 2
8 compressor 2 circuit 1
9 compressor 1 circuit 2
10 compressor 2 circuit 2
11 reversing valve

Fig. 4.v 

4.9 Water-cooled condensing unit

4.9.1 Single circuit
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Key:
1 flow switch
2 cond. water temperature probe
3 condenser
4 compressor 1
5 high pressure
6 compressor thermal protector
7 low pressure
8 compressor 2

Fig. 4.w 
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4.9.2 Two circuits
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Key:
1 flow switch
2 cond. water temperature probe
3 condenser
4 compressor 1 circuit 1
5 high pressure
6 compressor thermal protector
7 low pressure
8 compressor 2 circuit 1
9 compressor 1 circuit 2
10 compressor 2 circuit 2
11 water pump

Fig. 4.x 

4.10 Reverse-cycle water-cooled condensing unit

4.10.1 Single circuit

21
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Key:
1 condenser probe
2 condenser
3 frost protection heater
4 compressor 1
5 high pressure
6 compressor thermal protector
7 low pressure
8 compressor 2
9 reversing valve

Fig. 4.y 
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4.10.2 Two circuits
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Key:
1 condenser probe
2 condenser 1 & 2
3 frost protection heater 1 & 2
4 reversing valve
5 compressor 1 circuit 1
6 high pressure 1 & 2
7 compressor 1 & 2 thermal protector
8 low pressure 1 & 2
9 compressor 1 circuit 2
10 compressor 2 circuit 1
11 compressor 2 circuit 2
12 water pump

Fig. 4.z 
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5. COMMISSIONING
5.1 APPLICA app

about 5 m

about 1 cm

Fig. 5.a

The “Applica” app can be used to configure the controller from a mobile 
device (smartphone, tablet), via NFC (Near Field Communication) and 
Bluetooth (BLE). Users can both configure the commissioning parameters 
and set groups of preset parameters according to specific needs (recipes).

Once the Carel “Applica” app has been installed and opened (see the 
paragraph “Mobile device”, proceed as follows:
1. For NFC devices, move (A) the mobile device near to the μChiller user 

terminal (the position of the NFC antenna on the mobile device must 
be identified in order to place it over the display): wait for the signal 
that the device has been read (B).

2. 2. For Bluetooth devices (C), select the "SCAN BLUETOOTH" 
option, then choose the device from the list.

5.2 Config. procedure - Legacy model

5.2.1 Step 1 - Set the refrigerant

Notice: refer to the table of models in the "Introduction".

1. With Bluetooth devices, access the Service menu by clicking the icon 
at the bottom right (figure). With NFC devices, the Service menu is 
already displayed by default (figure below point 2);

2. click "Set-up"--> "Configurations" -->"Defaults" (figure);

3. select the refrigerant used in the unit;
4. apply the selected configuration via NFC or Bluetooth. The 

refrigerant has now been correctly configured;

5.2.2 Step 2 - Configure the unit

1. continue configuring the unit by clicking the “Set-up"--> “Unit setup” 
--> “Unit configuration”. Complete the unit configuration by pressing 
the PREV / NEXT buttons to scroll through all of the configuration 
parameter pages;

2. apply the parameters configured via NFC / Bluetooth to the controller.
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5.2.3 Step 3 - Configure the inputs/outputs

1. click "Set-up"--> "Unit setup" --> "IO configuration". Complete the 
unit configuration by pressing the PREV / NEXT buttons to scroll 
through all of the configuration parameter pages;.

2. apply the parameters configured via NFC / Bluetooth to the controller.

5.2.4 Step 4 - Configure parameter compatibility 
with mCH2

1. click "Set-up"--> "Unit setup" --> "mCH2 parameters" and complete 
the configuration of the unit

2. apply the parameters configured via NFC / Bluetooth to the controller.
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5.2.5 Applica: date and time setting

Applica includes a feature for setting the date and time on μChiller in just 
one simple step, copying the values from the mobile device.

 
Procedure:
1. open Applica on the mobile device;
2. access the controller via NFC or Bluetooth, entering your profile 

credentials;
3. access the menu on the command bar at the top left;
4. select "set date/time":
5. confirm;
6. with an NFC connection, move the device near to the user terminal 

to write the copied values.

Notice: with a Bluetooth connection, the values are copied on 
confirmation.

5.2.6 Applica: copy configuration
Applica includes a "Clone" feature to acquire the configuration from one 
unit and replicate it “one-for-one” to other units.

Procedure:
1. open Applica on the mobile device;
2.  access the controller via NFC or Bluetooth, using the “Service” or 

“Manufacturer” profile credentials;
3. follow the path "Configurations/Clone";
4. enter a name to describe the configuration being saved;
5. with an NFC connection: move the device bear to the display 

terminal on the μChiller that the configuration is being copied from; 
once the message shows the configuration has been acquired, this 
is saved to the smartphone’s memory, available via icon 2 (see the 
following figure);

6. select the saved configuration; (with an NFC connection) move the 
device near to the display terminal on the μChiller that the same 
configuration is being applied to;

7. confirm and wait for the confirmation message.

Notice: with a Bluetooth connection the configuration is saved/applied 
on confirmation.

With reference to the previous figure, tapping the icon:
1. accesses the configurations saved by the user;
2. accesses the configurations prepared by Carel;
3. accesses the saved clones.
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5.3 Unit set-up parameter list

5.3.1 Unit parameters

Notice:  follow the order shown in the table to configure the Unit set-up 
parameters.

Par. Description Def. Min. Max. UOM
U077 Type of unit

0=CH; 
1=HP;
2=CH/HP:
3=Cooling-only condensing unit;
4=Reverse-cycle condensing unit;
5=Cooling-only air/air;
6=Reverse-cycle air/air/air;

0 0 6 -

S068 Source type (0=Air, 1=Water) 0 0 1 -
U076 Number of system pumps 1 1 2 -
C046 No. of unit circuits 1 1 2 -
C047 Type of compressors used (0=1 On/Off; 1=2 On/Off; 2=1 BLDC; 3=1 BLDC+On/Off ) 0 0 1/3 -
S065 Type of source fan (0/1=Modulating/ON-OFF) 0 0 1 -
S064 Type of source air circuit (0=Independent; 1=Common) 0 0 1 -
S072 Source pump activation

0=always on
1=On with compressors on
2=control on condensing temperature

0 0 1 -

E047 ExV driver (0=Disabled; 1=Built-in; 2=EVD Evolution) 0 0 2 -
E046 EVD Evolution: valve (1=CAREL ExV, ...) (*)

(*) see EVD Evolution manual for the complete list of selectable valves
1 1 24 -

E020 MOP in cooling: threshold 30.0 -60.0 200.0 °C
E022 MOP in heating: threshold 20.0 -60.0 200.0 °C
C017 Max high pressure threshold (HP) 65.0 0.0 999.9 °C
C018 Min low pressure threshold (LP) 0.2 -99.9 99.9 bar
U068 Free cooling: enable (0/1=no/yes) 0 0 1 -
U074 Free cooling type (0=Air; 1=Remote coil; 2=Water) 0 0 2 -
U071 Design free cooling delta T 8.0 0.0 99.9 K
U061 System pump overload: input logic (0/1=NC/NO) 0 0 1 -
U065 Freecooling valve: output logic (0/1=NO/NC) 0 0 1 -
S063 Reversing valve: output logic (0/1=NO/NC) 0 0 1 -
S054 4-way valve: pressure differential for reversing 3.0 0.0 999.9 bar
C049 Low pressure switch alarm delay on compressor activation 90 0 999 -
C050 Low pressure switch alarm delay with compressor on 15 0 999 -
C051 Low pressure switch input logic (0=NC; 1=NA) 0 0 1 -
S053 Defrost synchronisation (0=Independent, 1=Separate, 2=Simultaneous) 0 0 2 -
U006 Cooling set point: minimum limit 5.0 -99.9 999.9 °C
U007 Cooling set point: maximum limit 20.0 -99.9 999.9 °C
U008 Heating set point: minimum limit 30.0 0.0 999.9 °C
U009 Heating set point: maximum limit 45.0 0.0 999.9 °C
Hc13 Buzzer (0/1=No/Yes) 1 0 1 -
U081 High/low pressure and frost alarm reset configuration

0= HP1-2/LP1-2/A1-2/Manual frost protection
1= HP1-2/LP1-2/A1-2/Automatic frost protection
2= HP1-2/A1-2 Manual frost protection LP1-2 automatic
3= HP1-2 manual LP1-2/A1-2 Automatic frost protection
4= HP1-2/LP1-2 manual A1-2/Automatic frost protection
5= HP1-2/LP1-2 (3 times in an hour) manual; A1-2/Automatic frost protection
6= HP1-2/LP1-2 (3 times in an hour) manual; A1-2/Manual frost protection
7=HP1-2 manual/LP1-2 (3 times in an hour)/Manual frost protection

7 0 7 -

Tab. 5.a  
(*) see EVD Evolution manual for the complete list of selectable valves
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5.3.2 I/O configuration
For the description of the following parameters, see chapter 3 of this docu-
ment

Par. Description Def. Min. Max. UOM
HC31 Analogue input 1 configuration Master 7 0 8 -
HC32 Analogue input 2 configuration Master 8 0 8 -
HC00 Analogue input 3 configuration Master 0 0 8 -
HC34 Analogue input 4 configuration Master 7 0 10 -
HC35 Analogue input 5 configuration Master 8 0 10 -
HC03 Analogue input 6 configuration Master 0 0 11 -
HC04 Analogue input 7 configuration Master 6 0 8 -
HC41 Analogue input 1 configuration Slave 0 0 8 -
HC42 Analogue input 2 configuration Slave 0 0 8 -
HC43 Analogue input 3 configuration Slave 0 0 8 -
HC44 Analogue input 4 configuration Slave 7 0 10 -
HC45 Analogue input 5 configuration Slave 8 0 10 -
HC05 Analogue input 6 configuration Slave 0 0 11 -
HC47 Analogue input 7 configuration Slave 6 0 8 -
HC14 Digital input 1 configuration Master 1 0 12 -
HC15 Digital input 2 configuration Master 2 0 12 -
HC06 Digital input 4 configuration Master 0 0 12 -
HC07 Digital input 5 configuration Master 7 0 12 -
HC08 Digital input 6 configuration Master 6 0 12 -
HC16 Digital input 1 configuration Slave 10 0 12 -
HC17 Digital input 2 configuration Slave 2 0 12 -
HC09 Digital input 4 configuration Slave 0 0 12 -
HC10 Digital input 5 configuration Slave 7 0 12 -
HC11 Digital input 6 configuration Slave 0 0 12 -
HC71 Analogue output 1 configuration Master 1 0 3 -
HC72 Analogue output 2 configuration Master 3 0 3 -
HC81 Analogue output 1 configuration Slave 1 0 3 -
HC82 Analogue output 2 configuration Slave 0 0 3 -
HC51 Digital output 1 configuration Master 1 0 12 -
HC52 Digital output 2 configuration Master 2 0 12 -
HC53 Digital output 3 configuration Master 4 0 12 -
HC54 Digital output 4 configuration Master 7 0 12 -
HC55 Digital output 5 configuration Master 10 0 12 -
HC56 Digital output 6 configuration Master 0 0 12 -
HC61 Digital output 1 configuration Slave 1 0 8 -
HC62 Digital output 2 configuration Slave 2 0 8 -
HC63 Digital output 3 configuration Slave 4 0 8 -
HC64 Digital output 4 configuration Slave 7 0 8 -
HC65 Digital output 5 configuration Slave 0 0 8 -
HC66 Digital output 6 configuration Slave 0 0 8 -
C037 Evaporation pressure:  

probe type (0=0-5V; 1=4-20mA)
0 0 1 -

C038 Evaporation pressure probe: min value 0.0 -1.0 99.9 bar
C039 Evaporation pressure probe: max value 17.3 0.0 99.9 bar
C040 Condensing pressure:  

probe type (0=0-5V; 1=4-20mA)
0 0 1 -

C041 Condensing pressure probe: min value 0.0 -1.0 99.9 bar
C042 Condensing pressure probe: max value 45.0 0.0 99.9 bar

Tab. 5.b 

5.3.3 mCH2 parameters

Par. Description Def. Min. Max. UOM
F027 Compressors at part load (0=NO, 1=YES) 0 0 1 -
F003 Number of evaporators (0=1; 1=2) 0 0 1 -
F007 Sensor S4 installed on the source heat 

exchanger (0=No, 1=Yes: in CH mode 
reads condensing temp., in HP mode 
reads evap. temp.)

0 0 1 -

F008 Frost protection alarm delay 10 0 999 -
F009 Supply air temperature limit threshold 14.0 0.0 99.9 °C
F010 Supply air temperature limit diff. 4.0 0.0 20.0 °K
F011 Heater dig. output logic (0=NO; 1=NC) 0 0 1 -
F012 Offset on set point in 

cooling operation for the heaters
1.0 0.0 99.9 °K

F013 Differential on set point in cooling mode 
for the heaters

0.5 0.2 99.9 °K

F014 Offset on set point in 
heating mode for the heaters

3.0 0.0 99.9 °K

F015 Differential on set point in heating mode 
for the heaters

1.0 0.2 99.9 °K

F016 Heaters active during defrost  
(0=No, 1=Yes)

0 0 1 -

F017 Supply fan operating mode (0=Always 
ON; 1=ON 
by temp. control)

0 0 1 -

F018 Hot-start set point 40.0 0.0 99.9 °C
F019 Hot-keep differential 5.0 0.0 99.9 °K
F020 Compressor request logic 

from digital input (0=NC; 1=NO)
1 0 1 -

F021 Mixed water outlet temperature 
probe calibration (S1 expansion)

0.0 -99.9 99.9 °K

F022 Evaporator 2 water outlet temperature 
probe calibration (S2 expansion)

0.0 -99.9 99.9 °K

F023 Direct relationship between digital 
inputs 
and digital outputs for 
condensing unit (0=No, 1=Yes)

0 0 1 -

F024 Manual heater 1 management 
(0=AUTO; 1= OFF; 2=ON)

0 0 2 -

F025 Manual heater 2 management 
(0=AUTO; 1= OFF; 2=ON)

0 0 2 -

F026 Compressors off at low outside temper-
ature (air/air)

-40.0 -40.0 99.9 °C

Tab. 5.c 
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5.4 Applica Desktop
Applica Desktop is a program intended for manufacturers and installers 
of units fitted with the μChiller controller. It can be downloaded from ksa.
carel.com.
The Applica Desktop offers the possibility to:
• access the controller using the assigned profile;
• create configurations;
• apply configurations;
• clone a unit configuration, i.e. copy all of the unit’s parameter values;
• complete the commissioning procedure;
• troubleshoot any problems on the unit.

Note:
• Applica Desktop can be used as an alternative to the Applica app, and 

requires an internet connection;
• For the physical connection to the BMS port on μChiller, use the USB/

RS485 converter P/N CVSTDUMOR0

Fig. 5.b

5.4.1 Preparing for operation
1. Access KSA, "Software & Support","µChiller” section.
2.  Select the "Configurations" folder.
3. For μChiller Standard, Enhanced and Legacy models (with On/

Off compressor), select the "Refrigerants" section and then the 
refrigerant charged on the unit.

4. Connect to the BMS port on the μChiller controller, as shown in 
Figure 5.b;

5. Open Applica Desktop; a window will be opened with the right part 
of the top bar as shown below:

6. Select "Add target" and assign it a meaningful name (e.g.
7. In the "COM Port" field, enter the COM port used for the USB 

connection to the USB/RS485 converter;
8. Configure the connection parameters (Baudrate=115200, Bits=8, 

Parity=None, Stop Bits=Two, Serial Node=1) as shown in the figure 
(the data are saved automatically);

9. Use "Connect" to connect to the μChiller (which must be powered 
on).
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5.5 Configuration procedure with Applica 
Desktop - Legacy Model

5.5.1 Step 1 - Set the refrigerant
Once connected, select the "Configurations" label: the command bar will 
be displayed, as shown:

1. Select "File -> Import" to load the refrigerant configurations 
downloaded from KSA;

2. Select the configuration to be applied to the μChiller, and then 
"Apply Configuration";

3. Applica Desktop will display a message when the parameters 
have been set, and if necessary indicating any values that have 
been applied that do not belong to the current user profile (some 
parameters may not be visible to the user).

5.5.2 Step 2 - Configure µChiller
1. Select the "Configurations" label, select "New -> New configuration" 

and assign a name to the new configuration being created.

2. Select the newly created configuration
3. Select "Edit -> Apply Live Values". This operation copies the values 

of the parameters currently saved on the connected µChiller to the 
newly created configuration.

4. Select the "Tags" label and then the "Unit_Cfg" command
5. Change the parameters listed in the "Configuration value" column to 

configure the unit
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6. Repeat the same steps for the "IO_CFG" and "uCH2SE” tags.
7. The unit has now been configured. If desired, the control parameters 

can be modified using the other tags available as search filters.
8. Once all of the desired parameters have been changed, to apply 

the changes select the "Configuration" label and select "Apply 
Configuration"

Finally, to save the newly-created configuration for future use, from the 
"Configurations" label select "File -> Export" and assign a name to the 
configuration being saved.

5.5.3 Applica Desktop: date and time setting

Applica Desktop can set the date and time on μChiller in just one simple 
step, copying the values from the PC to the controller.

Procedure:
1. Once connected, select “Set date&time”;
2. In the pop-up window, confirm synchronisation of the time and date 

on µChiller with the PC
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Notes
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